OpenEnterprise Alarm Server Reference Guide (V2.83)
Contents

1  Alarm Server ................................................................................................................................................. 1
   1.1  Alarm Server Overview .......................................................................................................................... 1
   1.2  Client-Server Application Architecture ............................................................................................. 1
   1.3  Pre-Starting Server Components ........................................................................................................ 1
   1.4  Auto Termination and the Alarm Server ............................................................................................... 2
   1.5  Main Dialog ............................................................................................................................................. 2
         1.5.1  File Menu ......................................................................................................................................... 3
         1.5.2  Edit Menu ......................................................................................................................................... 3
         1.5.3  View Menu ....................................................................................................................................... 3
         1.5.4  Help Menu ....................................................................................................................................... 3
         1.5.5  Toolbar ............................................................................................................................................. 3
         1.5.6  Connected Databases List ............................................................................................................. 3
               1.5.6.1  Common Databases .............................................................................................................. 3
               1.5.6.2  Options Database .................................................................................................................. 4
               1.5.6.3  Messages Database .............................................................................................................. 4
               1.5.6.4  Subscription Database ........................................................................................................ 4
         1.5.7  Options Available ............................................................................................................................ 4
         1.5.8  Number of Client Subscriptions ...................................................................................................... 4
         1.5.9  Client Subscription List ................................................................................................................ 4
         1.5.10 Refresh Button .............................................................................................................................. 4
         1.5.11 Details Button ............................................................................................................................... 4
         1.5.12 Subscription Details Dialog ......................................................................................................... 4
               1.5.12.1  Subscription Name ............................................................................................................... 5
               1.5.12.2  Subscription Type ................................................................................................................ 5
               1.5.12.3  Subscription Database ....................................................................................................... 5
               1.5.12.4  Use Filter .......................................................................................................................... 5
         1.6  Properties Dialog .................................................................................................................................. 5
               1.6.1  General Tab .................................................................................................................................. 6
               1.6.1.1  Show System Tray Icon ........................................................................................................ 6
               1.6.1.2  Show Window ........................................................................................................................ 6
               1.6.1.3  Minimized ................................................................................................................................ 6
               1.6.1.4  Hide on Minimize .................................................................................................................. 6
               1.6.1.5  OK Button ................................................................................................................................ 6
               1.6.1.6  Cancel Button ....................................................................................................................... 7
         1.6.2  Databases Tab .................................................................................................................................... 7
               1.6.2.1  Common Databases ................................................................................................................ 7
               1.6.2.2  Add Button ................................................................................................................................ 7
               1.6.2.3  Remove Button ...................................................................................................................... 7
               1.6.2.4  Configured Options Database ............................................................................................... 7
               1.6.2.5  Configured Messages Database ............................................................................................ 7
               1.6.2.6  OK Button ................................................................................................................................ 8
               1.6.2.7  Cancel Button ....................................................................................................................... 8
               1.6.2.8  Add New Database Dialog ................................................................................................... 8
                      1.6.2.8.1  New Database .............................................................................................................. 8
                      1.6.2.8.2  OK Button .................................................................................................................. 8
                      1.6.2.8.3  New Database Cancel Button ...................................................................................... 8
2 Index .........................................................................................................................................9
1 Alarm Server

1.1 Alarm Server Overview

The Alarm Server is a software component that provides data requested by the Alarm View (which is a 'client' of the Alarm Server). The Alarm Server 'serves' the Alarm View with data from the database.

Like all of the Client Server components, the Alarm Server has its own User Interface (UI), which enables the user to specify and view the databases to which it is connected, and control the way the UI behaves. When it is running, its icon is visible in the System Tray at the bottom right of the Windows Desktop - . To display the UI, double click on this icon in the System Tray.

1.2 Client-Server Application Architecture

Most OpenEnterprise View components (e.g. Alarm View, Alarm Printer View, Trend View, OEGraphics View, Notes View) have what is known as three-tier Client-Server architecture. Each of the components listed above is a Client, which uses one or more Server components to provide them with the data that they request. This data is then displayed by the Client to the user. In turn, the Server component requests the data from what is usually a remote OpenEnterprise data source (Database Management System) running on an OpenEnterprise server. The Server component, is therefore a direct client of the OpenEnterprise database, but a Server of the OpenEnterprise View component (hence the term "three-tier"). Both Client and Server components must run on the same workstation, but the database usually runs on another machine.

1.3 Pre-Starting Server Components

All Server components are started automatically as a background process when a Client component starts up. They then close when the Client closes, except for the OPC and HDA Servers, which remain open by default. However, this can cause problems when Client components are being opened and closed rapidly. It is therefore recommended that Server components be started before any Client components begin requesting data from them. Obviously, if a Client component is not required, then the Server component is not required. The following are the Server components that should be started on an OpenEnterprise workstation before any of their 'Clients' begin running: -

- The Bristol OPC Server (Clients = OEGraphics and Trend View)
- The Bristol HDA Server (Client = Trend View)
- The Alarm Server (Clients = Alarm View, Alarm Banner)
- The Alarm Printer Server (Client = Alarm Printer View)
- The Notes Server (Client = Notes View)

These components reside in the OpenEnterprise bin directory (by default C:\Program Files\Bristol\OpenEnterprise\bin). They are executables, and may be started in any of the ways that an executable file is started (e.g. double clicking, batch file, Startup menu).
1.4 Auto Termination and the Alarm Server

By default, the Alarm Server does not close when a calling Client closes. This behaviour can be changed using the OpenEnterprise Settings Editor. Open the Settings Editor, and find the OpenEnterprise\Tasks\AlarmServer key. Then look for a value on this key named AutoTerminate. If one is not there already, create one, and set the data to 1.

To set the Server back to normal behaviour (i.e. to remain open when the Client closes) set the value data back to 0 (zero).

1.5 Main Dialog

This is the Main Dialog which provides the User Interface for the Alarm Server. It provides information on which databases the Server has connected to, enables the user to configure connectable databases, provides information regarding client processes that have connected to the Server and enables the user to configure the behaviour of the UI.
1.5.1 File Menu

The File Menu provides an option to Exit the application. This will cause the application to close as a Windows process if the Alarm Server is not currently supplying data to a client, but if it has a subscribing client, it will hide itself, but remain running as a process. The UI can be invoked again by double clicking on its icon in the System Tray.

1.5.2 Edit Menu

The Edit Menu provides an option to open the Properties dialog, which enables the user to configure pre-connect databases and the way that the UI behaves.

1.5.3 View Menu

There are two options available from this menu:

1. **Toolbar** - when checked, the toolbar is visible under the Menu bar.

2. **Status Bar** - when checked, the Status Bar is visible at the bottom of the Main Dialog window. It displays information on the current status of the Alarm Server.

1.5.4 Help Menu

This provides an option to open the About dialog, which provides information on the version and build of OpenEnterprise being used and contact information.

1.5.5 Toolbar

This contains two icons:

- **Properties icon** - selection opens the Alarm Server Properties dialog.

- **About icon** - selection opens the About dialog, which provides information on the version and build of OpenEnterprise being used and contact information.

1.5.6 Connected Databases List

Successful or failed database connections are displayed here. The databases listed can be of 4 types:

- Common databases

- A configured Options database

- A configured Messages database

- Any database connection requested by an Alarm View client

1.5.6.1 Common Databases

This is a list of databases that have been configured for the Alarm Server to connect to when it is started. This enables the Alarm Server to be started and connected to relevant databases before any Alarm View clients begin requesting alarm or event data.
1.5.6.2 Options Database

The database that should be used for retrieving the Options data. This is essentially a list of real-time and historical attributes, available conditions, priorities and color schemes that a default Alarm Client will use.

1.5.6.3 Messages Database

Identifies the name of the database to be used for Event Log Editing whereby a message can be inserted into the database's Event Log.

1.5.6.4 Subscription Database

The database that the Alarm View client has been configured to retrieve alarm or event data from.

1.5.7 Options Available

This box is checked automatically if the configured Options database is available. If the Options database is not available it is not checked. When the Options database is available, any un-configured Alarm View client in Runtime mode will retrieve alarm attributes, available conditions, priorities and default Alarm View color schemes from this database.

1.5.8 Number of Client Subscriptions

The number of Alarm View clients currently connected to the Alarm Server.

1.5.9 Client Subscription List

This list provides additional information on the Alarm View clients currently connected to the Alarm Server.

- **Name** - the internal name given to each separate Alarm Server object created for each Alarm View client.
- **Client Type** - an Alarm View client can either be configured as a *realtime* or *historical* type, but not both simultaneously. The *realtime* type will be requesting data from the AlarmSummary table, and the *historical* type will be requesting data from the EventHistory table.
- **Alarm/Event Count** - the number of Alarms or Events currently being returned to the client.

1.5.10 Refresh Button

Click this button to refresh the Alarm/Event count number.

1.5.11 Details Button

This button is only enabled when an entry in the Client Subscription list is selected. Clicking on the button will display the Subscription Details dialog, which gives further information on the data being requested by the selected Alarm View client.

1.5.12 Subscription Details Dialog

The Subscription Details dialog gives further information about the selected client subscription. The database from which the Alarm View client is requesting alarm or event data is displayed, as well as any filters that are being applied by the client.

Note that the information displayed on this dialog will differ depending on whether the Alarm View client is set up as a *Realtime* or *Historical* viewer.
1.5.12.1 Subscription Name

The internal name given to each separate Alarm Server object created for each Alarm View client.

1.5.12.2 Subscription Type

An Alarm View client can either be configured as a realtime or historical type, but not both simultaneously. The realtime type will be requesting data from the AlarmSummary table, and the historical type will be requesting data from the EventHistory table.

1.5.12.3 Subscription Database

The database that the Alarm View client has been configured to retrieve alarm or event data from.

1.5.12.4 Use Filter

States whether the Alarm View client is applying a filter to its query. If this value is Yes, there will be a list of properties and values below this that comprise the filters being applied.

1.6 Properties Dialog

The Edit Menu on the Main Dialog provides an option to open the Properties dialog, which enables the user to configure pre-connect databases and the way that the UI behaves. The Properties Dialog has two configuration tabs:-

- General Tab
- Databases Tab
1.6.1 General Tab

This tab on the Property dialog enables the user to configure the way that the Alarm Server User Interface behaves. Changes are implemented when the user selects the [OK] button at the bottom of the Properties dialog.

1.6.1.1 Show System Tray Icon

When checked, the Alarm Server icon - ![system tray icon] - will be displayed in the System Tray when it is running. Double clicking on this icon in the System Tray will open the Alarm Server's User Interface.

1.6.1.2 Show Window

When checked, the Alarm Server's User Interface will be displayed on startup.

1.6.1.3 Minimized

When the Show Window box is checked, this option becomes enabled. If checked, on startup the Alarm Server's User Interface will be displayed as a minimized icon on the Windows Task Bar.

1.6.1.4 Hide on Minimize

If checked, when the Alarm Server's User Interface is minimized, it will also be hidden. If the Show System Tray Icon box and ShowWindow boxes are unchecked at the same time that this box is checked, then at startup the Alarm Server's User Interface will not be available.

The interface may be restored by using the Settings Editor to manually change the ShowtrayIcon value on the OpenEnterprise\Tasks\AlarmServer key to 1. A restart will be necessary before the change takes effect.

1.6.1.5 OK Button

When this button is selected, changes made to any tab are saved, and the Property dialog is closed. Changes will be applied immediately.
1.6.1.6 Cancel Button

When this button is selected, the Property dialog is closed without saving any changes made on either tab.

1.6.2 Databases Tab

This tab on the Property dialog enables the user to configure databases that the Alarm Server will attempt to connect to next time it is started.

1.6.2.1 Common Databases

This is a list of databases that have been configured for the Alarm Server to connect to when it is started. This enables the Alarm Server to be started and connected to relevant databases before any Alarm View clients begin requesting alarm or event data.

1.6.2.2 Add Button

Selection of this button opens the Add New Database dialog, which enables you to define and add a new Common Database to the list.

1.6.2.3 Remove Button

Selection of this button removes a selected database from the Common Databases list.

1.6.2.4 Configured Options Database

A pre-defined Options database can be configured here. The Options database is used for retrieving the Options data. This is essentially a list of real-time and historical attributes, available conditions, priorities and color schemes that a default Alarm Client will use. It may be different to the Messages database.

1.6.2.5 Configured Messages Database

A pre-defined Messages database can be configured here. The Messages database is used for Event Log Editing whereby a message can be inserted into the database's Event Log. It may be different to the Options database.
1.6.2.6 OK Button

When this button is selected, changes made to any tab are saved, and the Property dialog is closed. Changes will be applied immediately.

1.6.2.7 Cancel Button

When this button is selected, the Property dialog is closed without saving any changes made on either tab.

1.6.2.8 Add New Database Dialog

This dialog enables a Common database to be defined and configured for the Alarm Server. The Alarm Server will attempt connection with all defined Common databases on start-up, regardless of whether any Alarm View clients are requesting data.

1.6.2.8.1 New Database

Type in the name of the new database here. A database name is comprised of <ServerName>:<DataPortConnection>. By default the DataPortConnection is defined as rtrdb1 and has a TCP/IP port value of 11001 in the <Drive>:<WinFolder>\System32\Drivers\etc\Services file.

1.6.2.8.2 OK Button

When this button is selected, the database defined in the New Database field will be added to the Common Databases list.

1.6.2.8.3 New Database Cancel Button

When selected, this button closes the Add New Database dialog without adding the name currently defined in the New Database field to the Common Databases list.
2 Index

A
Add Button ......................................................... 9
Add New Database Dialog ......................... 10
Alarm Server Overview .............................. 3
C
Cancel Button ................................................. 8, 9
Client Subscription List .............................. 6
Client Subscriptions ........................................ 6
Number .......................................................... 6
Client-Server Application Architecture ........ 3
Common Databases ................................. 5, 9
Configured Messages Database ................. 9
Configured Options Database .................. 9
Connected Databases List ...................... 5
D
Databases Tab ................................................... 9
Details Button .............................................. 6
E
Edit Menu ..................................................... 4
G
General Tab ..................................................... 8
H
Help Menu ...................................................... 5
Hide on Minimize ........................................ 8
M
Main Dialog ...................................................... 4
Messages Database ........................................ 5
Minimized ..................................................... 8
N
New Database .................................................. 10
New Database Cancel Button .................... 10
New Database OK Button ......................... 10
Number ........................................................ 6
Client Subscriptions ................................ 6
O
OK Button ..................................................... 8, 9
Options Available ........................................ 5
Options Database ........................................ 5
P
Pre-Starting Server Components ................. 3
R
Refresh Button .............................................. 6
Remove Button ............................................ 9
S
Show System Tray Icon .............................. 8
Show Window ................................................ 8
Subscription Database ............................ 5, 7
Subscription Details Dialog ..................... 6
Subscription Name ..................................... 7
Subscription Type ..................................... 7
U
Use Filter ......................................................... 7
V
View Menu ..................................................... 5
DISCLAIMER

Bristol, Inc., Bristol Babcock Ltd, Bristol Canada, BBI SA de CV and the Flow Computer Division, are wholly owned subsidiaries of Emerson Electric Co. doing business as Remote Automation Solutions (“RAS”), a division of Emerson Process Management. ROC, FloBoss, ROCLINK, Bristol, Bristol Babcock, ControlWave, TeleFlow and Helicoil are trademarks of RAS. AMS, PlantWeb and the PlantWeb logo are marks of Emerson Electric Co. The Emerson logo is a trademark and service mark of the Emerson Electric Co. All other marks are property of their respective owners.

The contents of this publication are presented for informational purposes only. While every effort has been made to ensure informational accuracy, they are not to be construed as warranties or guarantees, express or implied, regarding the products or services described herein or their use or applicability. RAS reserves the right to modify or improve the designs or specifications of such products at any time without notice. All sales are governed by RAS’ terms and conditions which are available upon request. RAS does not assume responsibility for the selection, use or maintenance of any product. Responsibility for proper selection, use and maintenance of any RAS product remains solely with the purchaser and end-user.

Engineered and supported by:

Remote Automation Solutions,
Blackpole Road, Worcester, WR3 8YB, UK

Registered office: Meridian East, Leicester, LE19 1UX

Registered in England and Wales, Registration No. 00671801

VAT Reg No. GB 705 353 652